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1 Revision History

The following table shows important changes made in this document for each revision.

1.1 Revision 8.0

The following is a summary of the changes made in this revision.

+ Updated Table 1, page 2.

* Replaced Figure 4 on page 6.

* Replaced Figure 5 on page 7.

* Replaced Figure 7 on page 8.

* Replaced Figure 8 on page 10.

*  Updated Reset Structure, page 8.

* Updated Running the Simulation, page 13.

1.2 Revision 7.0

The following is a summary of the changes made in this revision.

* Replaced Figure 4 on page 6, and Figure 8 on page 10 through Figure 10 on page 11.
* Added Appendix 1: Programming the Device Using FlashPro Express, page 23.

*  Added Appendix 2: Running the TCL Script, page 26.

*  Removed the references to Libero version numbers.

1.3 Revision 6.0

Updated the document for Libero SoC v11.9.

14 Revision 5.0

Updated the document for Libero v11.8 SP2.

1.5 Revision 4.0

Updated the document for Libero v11.7 SP1.

1.6 Revision 3.0

Updated the document for Libero v11.7.

1.7 Revision 2.0

Updated the document for Libero v11.6.

1.8 Revision 1.0

The first publication of this document.
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Interfacing RTG4 FPGA with External DDR3
Memory Through FDDR

2.1

This demo shows how the FPGA fabric logic can access external double-data-rate three (DDR3)
memories using built-in fabric double-data-rate (FDDR) in RTG4 devices.

The demo has two parts:
+  Simulation
*  Running the demo on the RTG4 Development Kit

In the demo design, the advanced extensible interface (AXI) master in the FPGA fabric accesses the
DDR memory present in the RTG4 Development Kit using the FDDR. A host utility,

RTG4 DDR Demo Utility is provided along with the demo design files. Using the utility, the AXI
master logic is driven. The AXI master converts the commands from the utility to AXI transactions for the
FDDR to perform the read or write operations on the external DDR3 memory.

Design Requirements

Table 1 shows the design requirements for running this demo design.

Table 1« Design Requirements

Requirement Version

Hardware

RTG4 FPGA Development Kit: RT4G150-CB1657PROTO FPGA

* USB 2.0 cable
* 12V, 5AAC power adapter and cords

Software

Libero® System-on-Chip (SoC) Note: Refer to the readme. txt file

FlashPro Express

provided in the design files for the
software versions used with this
reference design.

Host PC Drivers USB to UART drivers

Note: Libero SmartDesign and configuration screen shots shown in this guide are for illustration purpose only.

2.2

Open the Libero design to see the latest updates.

Prerequisites

Download and install Libero SoC (as indicated in the website for this design) on the host PC from the
following location: https://www.microsemi.com/product-directory/design-resources/1750-libero-soc

Microsemi Proprietary DG0625 Revision 8.0 2
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Demo Design

Introduction

The demo design files are available for download from the following path in the Microsemi website:
http://soc.microsemi.com/download/rsc/?f=rtg4_dg0625_df

The demo design files include:

+  Demo_Utility

* Libero_project

*  Programming_File
*  TCL_scripts

*  Source_File

* Readme.txt

Figure 1 shows the top-level structure of the design files. For further details, refer to the Readme . txt
file.

Demo Design Files Top-Level Structure

rtg4_dg0625_ df

—— Demo_Utility
—— Libero_Project

Programming File
Source_File

TCL_scripts

L—— Readme.txt

Figure 1 shows the top-level view of the demo design. In the demo design, the AXI master implemented
in the FPGA fabric accesses the DDR3 memory present on the RTG4 Development Kit using the FDDR.
The AXI master logic communicates to the FDDR through the CoreAXI interface and the DDR_FIC
interface. The read or write operations initiated by the RTG4 DDR Demo Utility are sent to the
UART_IF block using the UART protocol. The AXI master receives the address and data from the
UART_IF block.

During a write operation, the UART_IF block sends the address and data to the AXI master logic.

During a read operation, the UART _IF block sends the address to the AXI master. The AXI master reads
the data from DDR3 memory and stores it in TPSRAM. When the read operation is complete, the data
read is sent to the host PC through UART.

Microsemi Proprietary DG0625 Revision 8.0 3
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Figure 2+ RTG4 DDR Demo Block Diagram
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In this demo design, different blocks are configured, which are as follows:

+ FDDRis configured for DDR3 memory available on the RTG4 Development Kit. The DDR3 memory
is a Micron DRAM (Part Number: MT41K256M8DA-125 IT:K).
+ DDR_FIC is configured for AXI bus interface.
+  AXl clock is configured for 80 MHz and DDRS clock is configured for 320 MHz.
*  CoreUART IP has the following configuration:
+ Baud Rate: 115200
+ DataBits: 8
+  Parity: None
+ RTGA4TPSRAM has the following configuration:
*  Write port depth: 256
*  Write port width: 64
* Read port depth: 1024
*  Read port width: 16
For more information about the RTG4TPSRAM, refer to RTG4 FPGA Two-Port Large SRAM
Configuration User's Guide.

For more information about how to configure the FDDR, refer to Appendix 3: RTG4 DDR Memory
Controller Configuration and Initialization, page 27.
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Figure 3 «

Demo Design Features
The RTG4 DDR demo design has the following features:

Single AXI read or write transactions

16-beat burst AXI read or write transactions
DDR3 memory model simulation using testbench
Design validation using the RTG4 Development Kit that has the DDR3 memory
Initiation of the read or write transactions using RTG4 DDR_Demo_ Utility

Demo Design Description

The demo design consists of the following SmartDesign components:

DDR_AXI_0: Handles the data transactions between the FDDR and the DDR3 SDRAM.
UART_IF_0: Handles the communication between the host PC and the RTG4 Development Kit.

Figure 3 shows the DDR_AXI_0 and UART_IF_O connection.
RTG4_DDR_Demo SmartDesign

DDR_AXI_0

[(DEVEST N@—— DEVRST_N BREADY
. read star AXI RBUSY
write_start AXI WBUSY
RLEFﬂS:O RREADY
WILEN[3: GLD

ARADDR. |rﬂ£31: S S
AWADDH inf[31: AX S RVALD

WDATA_int_inpui[63:0] Thit_donef
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UART_IF_0
RX, TX
CLK WRITE
RESET N READ
RREADY DATA_INPUT[E:
AX_RBUSY WRITE_ADDRESS|[31
RVALID RLEN[3:
BREADY WLEN[3:
LL BRIAST READ_ADDRESS[31:
AX_WBUSY
DATA_OUTPUT[E3:0] #
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251 DDR_AXI 0

DDR_AXI_0 consists of the FDDR subsystem and the AXI_IF_0 master logic. The AXI_IF_0 master logic
is an RTL code that implements the AXI read and write transactions. It receives the read or write
operations, burst length (RLEN and WLEN), address, and data as inputs. Based on inputs received, it
communicates with the DDR3 memory through the FDDR. Figure 4 shows the DDR_AXI_0 SmartDesign
component.

Figure 4+ DDR_AXI_0 SmartDesign Component
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252 UARTIF.0

The UART_IF_0 SmartDesign component handles the UART communication between the host PC demo
utility and the AXI master logic. The COREUART_O IP receives the UART signals from the host PC user
interface. The UART _IF_FSM_0 is a wrapper for the COREUART _0, collects the data from the
COREUART_O0 IP and converts the data to the relevant AXI_IF_0 master signals. For more information
about CoreUART, refer to CoreUART Handbook.

For a single write operation, the UART_IF_FSM_0 wrapper receives the address and data from the
demo utility. For a burst write operation, the address and data are received from the demo utility and the
subsequent incremental data is provided by the UART_IF_FSM_0 wrapper.

For a burst read operation, UART_IF_FSM_0 collects the address from the demo utility and sends that to
the AXI_IF_0 master logic. It receives the read data from the AXI_IF_0 master logic and stores it in the
RTG4TPSRAM_O0. After completion of the read burst transactions, the UART _IF_FSM_0 wrapper
fetches the stored data from the RTG4TPSRAM_0 and sends it to the COREUART IP. Figure 5 shows
the UART_IF_0 SmartDesign component. For more information about RTG4TPSRAM, refer to RTG4
FPGA Two-Port Large SRAM Configuration User Guide from Libero.

Figure 5+ UART_IF_0 SmartDesign Component
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Clocking Structure

The on-chip 50 MHz oscillator provides the reference clock to the FCCC and FCCCECALIB blocks. The
FCCCECALIB block provides two clocks, GLO (80 MHz) and GL1 (50 MHz). The GLO clock drives the
AXI_IF_0, UART_IF_O, and FDDRC_With_INIT_O blocks. The GL1 clock drives the CoreABC processor
inside the FDDRC_With_INIT_0 block. The following figure shows the clocking structure of the design.

For more information about FCCCECALIB, refer to UG0590: RTG4 FPGA Clock Conditioning Circuit with
PLL Configuration User Guide from Libero.

Clocking Structure

On-Chip 50 MHz
RC Oscillator
GL1
(50 MHz)
FCCCECALIB
GLO
(80 MHz)
Y \ 4 v v
AXI_IF_0O UART_IF 0 FDDRC_With_
INIT_O

Reset Structure

The POWER_ON_RESET signal is the input to the RTG4FCCCECALIB_CO and the output signal is
used in INIT_RESET_N and reset_synchronizer_0 to reset the FDDRC_With_INIT_O block. After the
reset of FDDRC_With_INIT_O, INIT_DONE signal is used in reset_synchronizer_1 to reset the AXI_IF_0
and UART_IF_0 blocks. The following figure shows the reset structure of the design.

Reset Structure

SYSRESET_N

Jv POWER_ON_RESET

GL1 reset_ CORE_RESET_N
» synchronizer_ >
’_. 0 INIT RESET N | FDDRC_With_INIT_0
RTG4FCCCECALIE_CO |LOCK !
GLO INIT_DONE
A

»{reset_synchronizer_1

reset_sync

| |

AXI_IF_0 UART_IF_D
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2.8 Resource Utilization

The following table lists the resource utilization of the design after place and route. These values may
vary slightly for different Libero runs, settings, and seed values. For IP-wise utilization, refer to the
respective handbooks.

Table 2 Resource Utilization

Type Used Total Percentage
4LUT 1120 151824  0.74
DFF 863 151824  0.57
I/0 Register 0 2151 0.00
Logic Element 1343 151824 0.88

29 Demo Design Simulation

The demo design can be simulated using a testbench and Micron DDR3 memory model.
The simulation is set to run the following:

+  Single AXI write and read operation

*  16-beat AXI burst write and read operation.

To run the simulation, ensure that the following files are present in the Libero SoC project:
e ddr3.v

* ddr3 parameters.vh
* testbench.v

The default location of the files is:
<Download folder>\Libero_Project\stimulus

291 Simulation Setup
The following steps describe how to set up the simulation.

Launch the Libero SoC software.

Browse the Libero Project project provided in the design file.
Choose Project > Project Settings > Simulation Options.

Ensure that the DO File tab has the configuration, as shown in Figure 8.

PON~
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Figure 8+ DO File Configuration
le)
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v
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Design flow
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=l Simulation options Testbench module name: [testbench

DO file
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VT commande I Generate VCD file

Timescale
= Simulation libraries VD fle name: [power.ved

COREAPB3_LIB

COREAX LIB User defined DO fle: | el

General Settings
Global Include Paths

DO command parameters: |

5. Ensure that the Waveforms tab has the configuration, as shown in Figure 9.

Figure 9+ Waveforms Configuration
@

¥ Indiude DO fie

s o [op v tatoenc =

design

RTG
COREAPE3 LIB
COREAX_LTB

eeeee I Settings

lobal Include Paths

G
Gl

6. Go to Design Flow tab.
7. Right-click Simulate under Verify Pre-Synthesized Design and select Organize Input Files >
Organize Stimulus Files..., as shown in Figure 10.
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Figure 10 + Design Flow Window - Simulate
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8. Ensure that the Organize Stimulus files window has the configuration, as shown in Figure 11.
Figure 11 » Organize Stimulus Files Window

[#" Organize Stimulus files of DDR_demo_top for Simulate tooh ; . i m

Click to select a Stimulus file in the project, and use the Add button to pass the file to the tool.

Use the Remove button to remove Stimulus files.

Use the Up/Down arrow buttons to specify the order of the Stimulus files when they're passed to the tool.

Use list of files organized by
(") Libero (default list)

[
@ Uuser I
Stimulus files in the project Origin i Associated Stimulus files Origin
il écoreparameters.v éSmartDesign = 1 ddr3v User
2 axi_masterv SmartDesign sl 2 testbench.v User
3 axi_slaveyv SmartDesign
4 coreparameters.v User
4= Remove
5 axi_masterv User
6 axi_slaveyv User o

o [ om
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29.2 Running the Simulation
The following steps describe how to run the simulation:

1. Right-click Simulate under Verify Pre-Synthesized Design.

2. Click Open Interactively.
Simulation run time is 1 ms, as shown in Figure 8 on page 10. Figure 12 shows the transcript win-
dow of the simulation.

Figure 12 » Transcript Window

¥ ModelSim Microsemi 103c - = 115

File Edit View Compile Simulate Add Transcript Tools Llayout Bookmarks Window Help
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¥ Transcript i
¥ testoencn.DDR3_J.cmd_task: at tilme %oUX39Z4U.U ps LNFOD Write bank U col UUU, auto precharge U j
# testbench.DDR3_0.data task: at time 450555720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000000 data = 50
# testbench.DDR3_1l.data_task: at time 450955720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000000 data = 78
# testbench.DDR3_2.data_task: at time 450555720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000000 data = 56
# testbench.DDR3_3.data_task: at time 450555720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000000 data = 34
# testbench.DDR3_0O.data_task: at time 450557220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000001 data = 12
# testbench.DDR3_1.data_task: at time 450957220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000001 data = ef
# testbench.DDR3_Z.data task: at time 450957220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000001 data = cd
# testbench.DDR3_3.data task: at time 450957220.0 ps INFO: WRITE @ DQRS= bank = 0 row = 0000 col = 00000001 data = ab
# testbench.DDR3_0O.data task: at time 450958720.0 ps INFO: WRITE @ DQRS= bank = 0 row = 0000 col = 00000002 data = 91
# testbench.DDR3_1.data_task: at time 450958720.0 ps INFC: WRITE @ DQS= bank = 0 row = 0000 col = 00000002 data = 78
# testbench.DDR3_2.data_task: at time 450958720.0 ps INFC: WRITE @ DQS= bank = 0 row = 0000 col = 00000002 data = 56
# testbench.DDR3_3.data_task: at time 450958720.0 ps INFC: WRITE @ DQS= bank = 0 row = 0000 col = 00000002 data = 34
# testbench.DDR3_0O.data_task: at time 450960220.0 ps INFC: WRITE @ DQS= bank = 0 row = 0000 col = 00000003 data = 12
# testbench.DDR3_1.data task: at time 450960220.0 ps INFC: WRITE @ DQS8= bank = 0 row = 0000 col = 00000003 data = ef
# testbench.DDR3_2.data task: at time 450960220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000003 data = cd
# testbench.DDR3_3.data task: at time 450960220.0 ps INFC: WRITE @ D(QS8= bank = 0 row = 0000 col = 00000003 data = ab
# testbench.DDR3_0O.data task: at time 450961720.0 ps INFC: WRITE @ DQS= bank = 0 row = 0000 col = 00000004 data = 32
# testbench.DDR3_1.data task: at time 450961720.0 ps INFC: WRITE @ D(QS= bank = 0 row = 0000 col = 00000004 data = 78
# testbench.DDR3_2.data task: at time 450961720.0 ps INFO: WRITE @ D(QS3= bank = 0 row = 0000 col = 00000004 data = 56
# testbench.DDR3_3.data task: at time 450961720.0 ps INFC: WRITE @ D(Q3= bank = 0 row = 0000 col = 00000004 data = 34
ks testbench.DDR3_0.data task: at time 4509€3220.0 p= INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000005 data = 12
ks testbench.DDR3_1.data task: at time 4509€3220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000005 data = ef
# testbench.DDR3_2.data task: at time 4505€3220.0 ps INFO: WRITE @ DES= bank = 0 row = 0000 col = 00000005 data = cd
# testbench.DDR3_3.data task: at time 45059€3220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000005 data = ab
# testbench.DDR3_0O.data_task: at time 450964720.0 ps INFO: WRITE @ DQ3= bank = 0 row = 0000 col = 00000006 data = 93 W
# testbench.DDR3_1l.data_task: at time 4509€4720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 0000000& data = 78
# testbench.DDR3_2.data_task: at time 450564720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 0000000& data = 56
# testbench.DDR3_3.data_task: at time 4505€4720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 0000000& data = 34
# testbench.DDR3_0O.data_task: at time 4505€6220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000007 data = 12
# testbench.DDR3_1.data_task: at time 4509€6220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000007 data = ef
# testbench.DDR3_Z.data task: at time 450966220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000007 data = cd
# testbench.DDR3_3.data task: at time 450966220.0 ps INFO: WRITE @ DRS= bank = 0 row = 0000 col = 00000007 data = ab
# testbench.DDR3_0O.cmd task: at time 451011220.0 ps INFO: Write bank 0 col 008, auto precharge 0O J
# testbench.DDR3_1.cmd task: at time 451011220.0 ps INFO: Write bank 0 col 008, auto precharge 0
# testbench.DDR3_2.cmd task: at time 451011220.0 ps INFO: Write bank 0 col 008, auto precharge 0
# testbench.DDR3_3.cmd task: at time 451011220.0 ps INFO: Write bank 0 col 008, auto precharge 0
# testbench.DDR3_0.data_task: at time 451027720.0 ps INFC: WRITE @ DQS= bank = 0 row = 0000 col = 00000008
# testbench.DDR3_1.data_task: at time 451027720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000008
# testbench.DDR3_2.data task: at time 451027720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000008
# testbench.DDR3_3.data task: at time 451027720.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 00000008
# testbench.DDR3 0O.data task: at time 45102%220.0 ps INFO: WRITE @ D(QS= bank = 0 row = 0000 col = 0000000%
# testbench.DDR3_1.data task: at time 45102%220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 0000000%
# testbench.DDR3_2.data task: at time 45102%220.0 ps INFO: WRITE @ DQS= bank = 0 row = 0000 col = 0000000%
# testbench.DDR3_3.data task: at time 451029%220.0 ps INFO: WRITE @ D(Q3= bank = 0 row = 0000 col = 00000009
# testbench.DDR3_0O.data task: at time 451030720.0 ps INFO: WRITE @ D(Q3= bank = 0 row = 0000 col = 0000000a
ft temathanch DNR2A 1 Aats +sak: =+ +ima 4510070 0 re TNRO= WRTTF A NOS= khank = 0 vaw = 0000 ~a1 = O00OOONANS

J- Transcript - [jaa] Wave J‘i{)b]ecrs llﬁl Processes JM Library IE Memaory List l@ sim J
Now: 679,773,875 ps Delta: 4 AXI_S_RREADY
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Figure 13 shows the single AXI write and AXI read operation as per AXI specification.

Figure 13 « Single AXI Write and Read Operation
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Now | 700000000 ps 463500000 ps. 463600000 ps. 463700000 ps. 463800000 ps. 463900000 ps. 464000000 ps.
] B ;
Figure 14 shows the 16-beat AXI burst write and read operation as per AXI specification.
Figure 14 » 16-Beat AXI Burst Write and Read
] Wave |
File Edit View Add Format Tools Bookmarks Window Help
s Wave -Defauit e
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< FODR _das._match_0_out o i 1
< FODR _dgs_tmatch_t_out o T 1
:
1 NN
0 1
f 0 IF
ez, BT
:
5 A 00000000 00000000
2 AX 1
)3 AXIS_AWD o
£ AXIS_AWLEN f 13
£ 39 AXIS_AWLOCK o
) 3 AXIS_AWSIZE 3
2 AXLS_AWVALID o il
(%) 5 AXI_S_WDATA abcdef12345. abcdef1234567891 0000000000000 2bedefiz3a56785F
3 AXIS_WID o T
> AXS_wLAST o n
£ 4 AXIS_WSTRB 7 i
2 AXS_WVALD o 1
3 AXIS_WREADY 1
£y AXIS_BID o T
< AXLS_BREADY o m
3 A S BVAD o 1
)y AXI_S_ERESP 0 T
e
& read start_th o ! -
&P RE f T IF
)29 ARADDR int 00000000 06000000
3 AXIS_ARREADY 1
) 4% AXIS_ARADDR 00000000 00000000
£ AXI_S_ARLEN T IF
) 19 AXI_S_ARSIZE 3 3
) 39 AXIS_ARBURST 1 T
49 AXIS_ARLOCK. o T
> AXS_ARVAD o m
2 AXIS_RREADY 0 I | L
3 A S RAD o 1 |
& A5 RLAST o -
(%) & AXI_S_RDATA ‘abcdef12345... | 10000000000000000 | 10000000000000000 0000000000000 shedef123456 785
)y AXI_S_RRESP. o T
4 AXISRID 0 T
¥ Now | 700000000 S | 300000 ps 464000000 ps 464200000 ps 464400000 ps 464600000 ps 464800000 ps 465000000 ps 465200000 ps 465400000 ps 465500000 ps
SO :

463780384 ps to 465686340 ps | FDDR_das_tmatch_t_out

These waveforms shows the AXI4 single and burst transfers initiated by AXI4 master. These AXI14
transactions are input to the FDDR, which converts them to read/write operations across external DDR3
memory.
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210 Demo Setup

This demo design uses the RTG4 Development Kit. Figure 15 on page 15 shows the RTG4 Development
Kit. The following steps describe how to set up the hardware demo:

1. Connect the jumpers on the RTG4 Development Kit, as shown in Table 3.
Table 3 « RTG4 Development Kit Jumper Settings

Jumper Pin (from) Pin (to) Comments
J32 1 2 Default
J27 1 2 Default
J26 1 2 Default
J23 1 2 Default
J21 1 2 Default
J19 1 2 Default
J1 1 2 Default
J16 2 3 Default

CAUTION: Ensure that the power supply switch SW6 is switched OFF while connecting the jumpers.

2. Connect the power supply to the J9 connector, switch ON the power supply switch, SW6.
3. Connectthe host PC USB port to the RTG4 Development Kit J47 USB connector using the USB Ato
mini-B cable.

Figure 15 » RTG4 Development Kit

VDD Regulator 3.3 V Regulator HPC2-FMC Breadboard RvI 5V Regulator 12 V Power

Circuit Circuit Connector Connector Header Circuit Supply Source
Debug SPI1 Reset
LEDs Flash Switch

Power
Measuremeqt ON-OFF
Clreist Switch

JTAG
Programming
Header

Debug
Switches

10/100/1000
Ethernet RJ45
Connector

HPC1-FMC
Connector

FT4232
Header

USB-UART
Terminal

DIP
Switch

SERDES_PCle5 SMA
Reference Clock

Marvell PHY x4 PCle Edge  FDDR1-DDR3  RTG4™ SERDES_PCle5 SMA  ETM Trace FDDRO-DDR3
Connector Memory Device Tx/Rx Pairs Debug Header Memory

4. Ensure that the USB to UART bridge drivers are automatically detected. This can be verified in the
Device Manager of the host PC. The future technology devices international (FTDI) USB to UART
converter enumerates four COM ports. For USB 2.0, note down the USB Serial Converter C COM
port number to use it in the GUI. Figure 16 shows the USB 2.0 serial port properties. As shown in
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Figure 16, COMG is connected to the USB serial converter C. Refer to "Appendix 4: Finding Correct
COM Port Number when Using USB 3.0" on page 31 for finding the correct COM port in USB 3.0.

Figure 16 » USB Serial 2.0 Port Properties
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USEB Serial Port (COME) Properties

General | Port Settings I Driver I Deiailsl

UUSB Serial Port (COME)

-
Device type: Ports (COM & LPT)
Manufacturer: FTDI
Location: on USB Seral Converter C
Device status

This device is working propery.

5. Ifthe USB to UART bridge drivers are not installed, download and install the drivers from
https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers.

2.1

Programming the Device

To program the RTG4 Development Kit with the job file provided as part of the design files using
FlashPro Express software, refer to Appendix 1: Programming the Device Using FlashPro Express,

page 23.

Microsemi Proprietary DG0625 Revision 8.0
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212 Running the Demo

The RTG4 DDR demo comes with a utility, RTG4 DDR Demo_ Utility thatruns on the host PC to
communicate with the RTG4 Development Kit. The UART protocol is used as the underlying
communication protocol between the host PC and the RTG4 Development Kit. Figure 17 shows the initial
screen of the RTG4 DDR Demo Utility.

Figure 17 « RTG4_DDR_Demo_Utility
£ Accessing DDR SDRAM [

Serial Port Configuration DDR Burst Read

COMPort  [COM29 = Address Data

»

>

Data Transfer Type
@ Single (8 - byte)

(") Burst (2048 - byte)

DDR SDRAM

Address 00000000

Gl
1

I Data 0123456789ABCDEF

= B Baaa RT1G4-

| 9 o — -

The RTG4_DDR_Demo_Utility consists of the following sections:

+  Serial Port Configuration: Displays the serial port. Baud rate is fixed at 115200.
+ Data Transfer Type: Single or Burst.

+ DDR SDRAM: Provides Address and Data.

+ DDR Burst Read: Displays the Burst Read values for the corresponding address.
+  C: Clears the existing data.
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Steps to Run the GUI

The following steps describe how to run the GUI:

1. Launch the utility. The default location is: <download_folder>\Demo_Ultility\RTG4_DDR.exe.

2. Select the appropriate COM Port from the drop down menu. In this case, it is COM 28.

3. Click Connect. The connection status along with the COM Port and Baud rate is shown in the left
bottom corner of the screen. Figure 18 shows the connection status of the utility.

Figure 18 + RTG4_DDR_Demo - Connection Status
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t onnected : USB Serial Port (COM28) - 115200'
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212.2 Performing a Single Data Transfer

For a single write or read operation, the AXI master logic is configured to transfer a burst length of 1 (that
is, 8 bytes). For a write operation, the utility sends a 32-bit address and 64-bit (8 bytes) data. The data is
then written to the DDR3 SDRAM. For a read operation, the utility sends a 32-bit address and receives
64-bit data from DDR3 and is displayed in the utility.

The following steps describe how to perform a single data transfer:

1. Select Single (8-bytes) as Data Transfer Type.

2. A64-bit aligned address is required in the address field. Enter a 32-bit HEX Address in the range
0x00000000 - 0x03FFFFF8. When a non 64-bit aligned address is provided, the GUI converts it to a
64-bit aligned address and performs the write or read. See "Appendix 5: Performing Write or Read
Operation when Non 64-bit Aligned Address is Provided" on page 33 to perform write or read
operation when non 64-bit aligned address is provided.

3. Inthe Data field, enter 64-bit data in HEX format.

4. Click Write. The entered data is written to the DDR3 memory. Figure 19 shows the Address and
Data values entered for a Single Write operation.

Figure 19 » Single Write Operation
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5. To verify the write operation, perform a read operation to the same address where the data is written.
6. Press C to clear the data present in the Data field. Figure 20 highlights the Clear button, C.

Figure 20 » Clear Data Field

| S Accessing DDR SDRAM g e e Bl st e - g o D == |
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»
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Write operation completed

7. Click Read to read the data from the DDR3 SDRAM. Figure 21 shows the data read from the DDR3
SDRAM.

Figure 21 « Single Read Operation

M ! =
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Serial Port Configuration DDR Burst Read
COMPort  [COM28 -| Address Data
»
Data Transfer Type
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W
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Read operation completed!

8. Compare the read and write data. The write and read data being the same establishes that the write
and read operations to the DDR3 SDRAM are successful.
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212.3 Performing Burst Data Transfer

For a burst write or read operation, the AXI master logic is configured to transfer a burst length of 16 (that
is, 128 bytes). In this demo, 16 transfers of 16-beat burst operations are implemented (16 transfers x 16-
beat burst data = 2048 bytes data). For a write operation, the utility sends a 32-bit initial address and 64-
bit (8 bytes) initial data. After the initial write operation, incremental data is written. For a read operation,
the utility sends a 32-bit address and receives 2048 bytes of data from the DDR3 SDRAM and the data is
displayed in the utility.

The following steps describe how to perform a burst data transfer:

1. Select Burst (2048-bytes) as Data Transfer Type.

2. A64-bit aligned address is required in the address field. Enter a 32-bit HEX Address in the range
0x00000000 - 0x03FFF7F8. When a non 64-bit aligned address is provided, the GUI converts it into
a 64-bit aligned address and performs the write or read operation. Refer to "Appendix 5: Performing
Write or Read Operation when Non 64-bit Aligned Address is Provided" on page 33 to perform write
or read operation when non 64-bit aligned address is provided.

3. Inthe Data field, enter 64-bit data in HEX format.

4. Click Write. The entered data is written to the address location specified in the Address field and
then the data is incremented by 1 and written to the next address location. This is repeated 256
times to write all the 2048 bytes of data. Figure 22 shows the Address and Data values entered for
a Burst Write operation.

Figure 22 « Burst Write Operation
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5. To verify the write operation, perform a read operation to the same address where the data is written.
6. Click Read. All the 2048 bytes of data written to the DDR3 SDRAM is read, and the read data is
displayed on the DDR Burst Read panel. Figure 23 shows the burst read data.

Burst Read Operation

£ Accessing DDR SDRAM
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Serial Port Configuration

DDR Burst Read

] »

I Read I

COM Port  |COM28 - | Address Data
v FFFFAAAAB9ABCDEF
— 00000008 | FFFFAAAABIABCDFO
i = 00000010 | FFFFAAAAB9ABCDFT
|} Single (8 - byte) !
= 00000018 | FFFFAAAAB9IABCDF2
[ st Sk 00000020 | FFFFAAAAB9ABCDF3
| [————— 00000028 | FFFFAAAABIABCDF4
00000030 | FFFFAAAAB9ABCDFS
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EEE— =

7. Click Exit to exit the u=tility.
Conclusion

This demo shows how to perform read or write operations to DDR3 SDRAM using RTG4 FDDR. Options
are provided to simulate the design using a testbench and validate the design on the RTG4 Development

Kit using a GUI interface.
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3 Appendix 1: Programming the Device Using
FlashPro Express

This section describes how to program the RTG4 device with the programming job file using FlashPro
Express.

To program the device, perform the following steps:

1.

2.

Ensure that the jumper settings on the board are the same as those listed in Table 3 of UG0617:
RTG4 Development Kit User Guide.

Optionally, jumper J32 can be set to connect pins 2-3 when using an external FlashPro4, FlashPro5,
or FlashPro6 programmer instead of the default jumper setting to use the embedded FlashPro5.

Note: The power supply switch, SW6 must be switched OFF while making the jumper connections.

3. Connect the power supply cable to the J9 connector on the board.

4. Power ON the power supply switch SW6.

5. If using the embedded FlashPro5, connect the USB cable to connector J47 and the host PC.
Alternatively, if using an external programmer, connect the ribbon cable to the JTAG header J22 and
connect the programmer to the host PC.

6. On the host PC, launch the FlashPro Express software.

7. Click New or select New Job Project from FlashPro Express Job from Project menu to create a

new job project, as shown in the Figure 24.

Figure 24 » FlashPro Express Job Project
[Z3 FlashPro Express
Project Edit View Programmer Help BB FrashPro Express
Job PI'OjECtS Project | Edit Vew Programmer Help
MNew Job Project from FlashPro Express Job  Ctrl+N - h
New... I . Open Job Project Ctri+0 b
Open... > sl
I tri+Shift+A
Recent Projects or e
Export Log File
Preferences...
Execute Script Ctri+U
Export Script File...
Recent Projects 4
Exit Ctri+Q
8. Enter the following in the New Job Project from FlashPro Express Job dialog box:

Programming job file: Click Browse, and navigate to the location where the .job file is located and
select the file. The default location is:

<download folder>/rtg4 dg0625 df/Programming File/top.job

FlashPro Express job project location: Click Browse and navigate to the desired FlashPro
Express project location.

Microsemi Proprietary DG0625 Revision 8.0 23


https://www.microsemi.com/document-portal/doc_download/135213-ug0617-rtg4-fpga-development-kit-user-guide
https://www.microsemi.com/document-portal/doc_download/135213-ug0617-rtg4-fpga-development-kit-user-guide

Appendix 1: Programming the Device Using FlashPro Express

Figure 25 « New Job Project from FlashPro Express Job

& Microsemi

a A%\ MicrocHIP company

E Create New Job Project

{+ Import FlashPro Express job file

|C:\t0p.j0b

" Construct automatically (developer mode) o

Browse...

Connected programmers: |

Programming interface:  JTAG

J Refresh

FlashPro Express job project name: |tc-p
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oK | Cancel |

9. Click OK. The required programming file is selected and ready to be programmed in the device.
10. The FlashPro Express window appears as shown Figure 26. Confirm that a programmer number
appears in the Programmer field. If it does not, confirm the board connections and click

Refresh/Rescan Programmers.
Figure 26 « Programming the Device

@ FlashPro Express  C\Dg_0625\top\top.pro - JTAG Programming Interface”
Project View Tools Help

Refresh/Rescan Programmers

O rrciso ]
Programmer
<2 TDO TOI O
1| @ _@ [13020F || DISABLED | DISABLED
2| @F GF|[e201308em IDLE IDLE

PROGRAM 4|

RUN

Log

E]Messages Eros 4 Wanings i Info

IDLE

FIUgIamE T T oo T TIImWET T=TOT

FP& design information:

FORMAT - MAJOR.minor : DESIGN_VERSION : FW_VERSION : USERCODE

Version: 01.00 : 0017 : 0008 : 000Q0QB73

Programmer: "E2013USPMI' : JIAG TCK / SPI S5SCKE freguency = 1 MHz
programmer '13802S8F' : FlashProé
programmer "E2013USPMI' : FlashProS

Rescanning for Programmers DONE.
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11. Click RUN. When the device is programmed successfully, a RUN PASSED status is displayed as
shown in Figure 27.

Figure 27 » FlashPro Express—RUN PASSED

E FlashPro Express  C\Dg_0625\top\top.pro - JTAG Programming Interface”
Project View Tools Help

Refresh/Rescan Programmers |

O rraciso E3

<7 TDO TOI &2
1| @1 gk [moer || DISABLED ]| DISABLED
OF @|Froen [INGIESSINN  EESSI

Programmer

o

|ProGRAM |
W 1PROGRAMMERS) PASSED

Log

@Messages QErrors /A, Warnings &Iﬂfc

T =TT =TT e wrToT T ERFURT IEITETOT =T

programmer "E2013USPMI' : device 'RT4GlS5S0"'" : Programming FPGA Array...

programmer "E2013USPMI' : device 'RTI4G150" :

programmer 'E2013USPMI' : device 'RT4G1l50' : EXPORT DSN[128] = 00000000000000000172cb0S8000a001e

programmer "E2013USPMI' : device 'RTI4G150" :

programmer "E2013USPMI' : device '"RTI4G1S50" : Finished: Thu Dec 17 12:31:43 2020 (Elapsed time 00:02:09)

programmer "E2013USPMI' : device '"RTI4G1lS0"'" : Executing action PROGRAM PASSED.

programmer "E2013USPMI' : Chain programming PASSED.

Chain Programming Finished: Thu Dec 17 12:31:43 2020 (Elapsed time 00:02:09)
0-0-0-0-0-0

12. Close FlashPro Express or click Exit in the Project tab.
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4 Appendix 2: Running the TCL Script

TCL scripts are provided in the design files folder under directory TCL_Scripts. If required, the design
flow can be reproduced from Design Implementation till generation of job file.

To run the TCL, follow the steps below:

1. Launch the Libero software

2. Select Project > Execute Script....

3. Click Browse and select script.tcl from the downloaded TCL_Scripts directory.
4. Click Run.

After successful execution of TCL script, Libero project is created within TCL_Scripts directory.
For more information about TCL scripts, refer to rtg4_dg0625_df/ITCL_Scripts/readme.txt.

Refer to Libero® SoC TCL Command Reference Guide for more details on TCL commands. Contact
Technical Support for any queries encountered when running the TCL script.
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Appendix 3: RTG4 DDR Memory Controller
Configuration and Initialization

Figure 28 »

This section describes how to configure and initialize the RTG4 DDR memory controller.

Launch RTG4 DDR Memory Controller with Initialization configurator using the RTG4 DDR Memory
Controller with initialization SgCore in Libero. Use the RTG4 DDR Memory Controller Configurator to
configure the FDDR, select its datapath bus interface (AXI or AMBA® high-performance bus (AHB)), and
select the DDR clock frequency as well as the fabric datapath clock frequency.

1. Inthe RTG4 DDR Memory Controller with Initialization configurator, under the General tab,
configure the settings as shown in Figure 28.

RTG4 FDDR Configuration Window

(" RTG4 DDR Memory Controller with initialization - FDDR

DDR memory settling time (us): 200

= [=]=]

import Configuration] [Export Configuration| |Restore Defaults)|

General | Memory Initisization | Memory Timing |

Identification

() EastFDDR @ West FDDR

Memory Settings

Memory Type [ooRs

Data Width [32

Clock Frequency (MHz) 320
SECDED Enabled ECC [
Address Mapping {ROW,BANK,COLUMN}

Row Bank

Column

Address Width (bits) [ 16 lE

Fabric Interface Settings

FPGA Fabric Interface [Using an AXI Interface

-

DDR VO

m

External Memary

FPGA FABRIC

FODR CLOCK Divisor [ {4

Use Fabric PLL Lock 7]

IO Drive Strength

@ Half Drive Strength

Enable Interrupts [

@) Ful Drive Strength

Fabric Memory Total
Clock Frequency Bandwidth Bandwidth

80 MHz 640 Mbps 5120 Mbps

<

Register Desaription

Microsemi Proprietary DG0625 Revision 8.0

27



Appendix 3: RTG4 DDR Memory Controller Configuration and Initialization © Microsemi

Figure 29 »
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2. Setthe register values for the FDDR registers to match the external DDR memory characteristics.

The FDDR has a set of registers that must be configured at runtime. The configuration values for
these registers represent different parameters. Use the Memory Initialization tab, as shown in
Figure 29 and the Memory Timing tab, as shown in Figure 30, to enter parameters that correspond
to the DDR Memory and application. Consult the DDR Memory vendor's datasheet for values to
enter in the Memory Initialization and Memory Timing tabs. Values entered in these tabs are
automatically translated to the appropriate register values. When a specific parameter is clicked, a
brief description of the corresponding register is described in the register description window of the
Fabric External Memory FDDR Configurator. For more details on FDDR configuration registers,
refer to UG0573: RTG4 FPGA High Speed DDR Interfaces User Guide.

FDDR Configurator - Memory Initialization tab

[®"| Fabric External Memory DDR Controller Conﬁgurato’ Lo ‘ |

Import Configuration | |Export Configuration| |Restore Defaults

I General Memory Initialization Memory Timing |

Burst Length s ~| sits
Burst Order lSequentiaI ']
Timing Mode [ar ~
CAS Latency (6 ~| cks
Self Refresh Enabled IND '] Bursts
Auto Refresh Burst Count [8 - |

[\ Powerdown Enabled [YES ']
Stop the Clock NO

Deep Powerdown Enabled |NO

Powerdown Entry Time a6

Additive CAS Latency 0 x| Clks
CAS Write Latency 5 = | Clks
Zqinit 512 Clks
ZQCs 64 Clks
ZQCS Interval 8389632 Clks
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Figure 30 »

5.1

5.2

Note:
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FDDR Configurator - Memory Timing tab

v - - - - .
[®"| Fabric External Memory DDR Controller Conﬂgurato; L B ‘ |

|1mpor‘t Conﬁguration] lExport Conﬁg@ Restore Defaults

| General | Memory Initialization || Memory Timing I
Time to Hold Reset before INIT 67584 Clks
MRD = | Clks
RAS ( Min ) 15 Clks
RAS ( Max ) 8192 Clks
RCD 6 Clks
RF 7 Clks
REFI 3104 Clks
RC 51 Clks
XP 3 Clks
CKE 3 Clks
RFC 79 Clks
WR 6 Clks
FAW 32 Clks

3. Instantiate the FDDR as part of a user application and make the datapath connections.

Importing DDR Configuration Files

In addition to entering DDR Memory parameters using the Memory Initialization and Timing tabs, the
DDR register values can be imported from a file. Click Import Configuration and navigate to the text file
with the DDR register names and values. The DDR3 configuration file for the Micron memory available
on the RTG4 Development Kit is provided along with the design files.

If the register values are imported and not entered using the GUI, then all the required register values
must be specified.

FDDR Initialization

The RTG4 DDR Memory Controller with initialization Sgcore has a built-in initialization state machine. On
the assertion or de-assertion of the INIT_RESET_N (Active Low) signal, the FDDR block is initialized
with the user configurations. When the configuration phase is complete, the INIT_DONE signal is
asserted and the FDDR block is ready for normal operations. The FDDR initialization can start
automatically at power up by connecting the INIT_RESET_N (Active Low) input of the FDDR block to the
POWER_ON_RESET_N (Active Low) signal of the SYSRESET macro.

The clock used for initialization must be a 50 MHz clock which is connected to the INIT_CLK 50 MHz
signal.
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5.3 DDR Memory Settling Time

The RTG4 DDR memory controller block is hard-coded with a DDR memory settling time of 200 ys,
assuming that the clock period of INIT_CLK is 20 ns (frequency 50 MHz). Microsemi recommends that
the initialization frequency be kept at 50 MHz.

Refer to the DDR Memory vendor's datasheet for the correct memory settling time to use. An incorrect
memory settling time may result in the failure of the DDR memory initialization, during operation. If a
different memory settling time is required for the DDR memory or a different INIT_CLK frequency is
chosen by the user, than the recommended 50 MHz, then the program code must be edited in the
Program tab of CoreABC to change the load value of the register used to compute the settling time.
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6 Appendix 4: Finding Correct COM Port
Number when Using USB 3.0

FTDI USB to UART converter enumerates the four COM ports. In USB 3.0, the four available COM ports
are in Location 0. Figure 31 shows the USB 3.0 Serial port properties.

Figure 31 + USB 3.0 Serial Port Properties

;_5;- Computer Management

= =] X
File Action View Help
= EE HE ® B &%
& Computer Management » g IDE ATAJATAPI controllers . e J_Acﬁpm
4 i} System Tools > %5 Imaging devices USB Serial Port (COM28) Properties o o I Y
» (D Task Scheduler b == Keyboards
» [ Event Viewer ¥ Mice and other pointing devices General | Pont Setings | Driver | Details| 4
> a2 Shared Folders b ‘:L Monitors
» & Local Users and Gr 4 &¥ Network adapters -
> (%) Performance ',;'." Bluetooth Device (Persanal Area Network)
&4 Device Manager ¥ Bluetooth Device (RFCOMM Protocal TDI) Device type: Ports (COM & LPT)
G . .
4 53 Storage L% Cisco Systems VPN Adapter for 64-bit Windows Manufacturer 1Ol
= Disk Management :'." Intel(R) Centrino(R) Advanced-N 6235
> B4 Services and Applicat '.i? Intel(R) Ethernet Connection 1217-LM I Location: Location 0 I
',;'." Microsoft Virtual WiFi Miniport Adapter #3 X
oo - - Device status
-&¥ Microsoft Virtual WiFi Miniport Adapter #4
4 'r?' Ports (COM & LPT) This device is working properly. -~
T? Communications Port (COM1)
YZX ECP Printer Port (LPT1)
> D Processors
b ¥ 5D host adapters
45> Smart card readers
b {5 sound, video and game controllers
> - System devices [ = J [ E—
T n > B Universal Serial Bus controllers
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The following steps describe how to find out the correct COM port:

-

Program the RTG4 Development Kit with the provided programming file.
2. Connect each available COM port and click Write.
If a wrong COM port is selected, the GUI displays the Read Error message.
3. Try with all four available COM ports until this message disappears.
Figure 32 shows the Read Error message.
Figure 32 + Read Error

7

£ Accessing DDR SDRAM = 22

Serial Port Configuration DDR Burst Read

COMPort  [COM29 = Address Data
> _

Data Transfer Type

@ Single (8 - byte) Read Error! u
A (") Burst (2048 - byte)

DDR SDRAM The operation has timed out.

" Address 00000000

Data 0123456789ABCDEF

Disconnect | | Wite | l Read l ?TGA:

Connected : USB Serial Port (COM29) - 115200
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7 Appendix 5: Performing Write or Read
Operation when Non 64-bit Aligned
Address is Provided

When a non 64-bit aligned address is provided in the GUI, the GUI converts it into the 64-bit aligned
address (0, 8, 10, 18, 20, 28, 30, 38 ...) and performs the write or read operation.

1. Enter the non 64-bit aligned 32-bit address in HEX format.

2. Enter the 64-bit data in HEX format. Figure 33 shows the non 64-bit aligned Address entered in the
GUL.

Figure 33 » Non 64-bit Aligned Address

Z Accessing DDR SDRAM = - 2 -

Serial Port Configuration DDR Burst Read

COM Port [COMQ&. - Address Data -

I E

Data Transfer Type
@ Single (8 - byte)
() Burst (2048 - byte)

DDR SDRAM
Address 00000015
Data 0123456789ABCDEF i

o] e (e RTG4-

Connected : USB Serial Port (COM28) - 115200
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3. Click Write to perform a write operation. GUI converts the address into a 64-bit aligned address and
performs the write operation. Figure 34 shows the GUI pop-up information message and converted
64-bit aligned address.

Figure 34 + Converted 64-bit Aligned Address

-

. Accessing DDR SDRAM =HIE
Serial Port Configuration DDR Burst Read
COM Port  [COM28 v | Address Datn i
- - =)
Data Transfer Type _! ,| -

-

@ Single (8 - byte) DDR SDRAM Address l
(C) Burst (2048 - byte)

DDR SDRAM [ B DDR SDRAM start address 0x00000015 is not 64-bit aligned.
Writing to 64-bit aligned start address 0x00000010

Address| 00000010

Data 0123456739ABCDH

romeeery I v M

Connected : USB Serial Port (COM28) - 115200
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